
Chapter-1 Computer System 

Practice Zone [Page no 9] 

  Suggest suitable devices for the following. 

 1. A journalist has to type a long article.Which input device should he use ? Keyboard 

 2. An employer wants to restrict access to a secure area such as boardroom. Which input device is 

the most suitable?Biometric Device 

 3. Which input device shouls shopkeeper use to generate bills by quickly reading information of 

products? Barcode Reader 

 4. Which input device is suitable for a banker who wants to process cheques? MICR 

 5. Which input device would help a teacher in evaluating answer sheets containing multiple 

choice questions?OMR 

 6. An artist wants to draw a landscape on a computer.He is not very computer using a mouse 

suggest an alternative input device for him. Stylus 

  Practice Zone [Page no 12] 

  Suggest suitable devices for the following. 

 1. Your father wants to deliver a presentation on a large screen to be shown to a large numbers of  

audience. – LCD projector 

 2. An architect wants to see the map of huge shopping complex saved on his computer on paper - 

Plotter 

 3. A printer for an office where hundred of letters have to be printed on a daily basis. – Laser 

printer 

 4. An economical printer for home where printouts have to be taken out occasionally-Inkjet 

printer 

  Assessment Zone [Page no 16-17] 

A.  Choose the correct answer. 

 1. Which of these devices is used for evaluating test papers by checking the presence or 

absence of marks on sheets? 

  a. OMR 

  b. OCR 

  c. Joystick 



  d. MICR 

 2. Which of the following devices is capable of recognising a person’s identity on the basis of 

her/his distinctive physical characteristics? 

  a. Barcode Reader 

  b. Biometric Device 

  c. MICR 

  d. Joystick 

 3. Which of the following is not a feature of RAM? 

  a. RAM is volatile 

  b. Information can be written into and read from RAM. 

  c. RAM stores a special piece of software called BIOS. 

  d. The amount of RAM insulated in a computer decides the number and size of programs 

that the system can run simultaneously. 
 4. Name the device used when data needs to be shown on a big screen or other flat surface. 

  a. LCD Projectors 

  b. Plotter 

  c. Printer 

  d. Monitor 

   

B.  State whether the following statements are true or false. 

  1. MICR is used to scan the code represented using sequence of vertical bars and spaces 

on products. False 

  2. Biometric devices are capable of recognising distinctive physical characteristics such as 

face, fingerprints and so on of a person. True 

  3. A CD can hold more data than a DVD. False 

  4. A mobile phone makes use of memory card to store data. -True 

  5. A scanner reads the text character by character and then produce a digital copy of the 

same. False 

  6. ROM is volatile-False 

   

C.  Fill in the blanks using word given in the box. 



  1. A device that is used for converting printed documents or photos in to electronic 

formats is called a scanner. 
  2. A touchpad is an input device that is usually used on a laptop and works by sensing the 

user’s finger movement and the applied pressure. 
  3. MICR is used in banks to read the information written on cheques. 

  4. Dot Matrix is an impact printer whereas Laser is a non-impact printer.  

  5. BIOS is stored on ROM. 

  6. A digital camera is used to capture images and store them in a digital format. 

   

   

   

D.  Answer the following questions 

 1. Expand OMR and MICR. Differentiate between the two on the basis of their area of 

application/usage by giving suitable example. 

OMR MICR 

OMR stands for Optical Mark 

Recognition. 

MICR stands for Magnetic Ink 

Character Recognition. 

It is used to recognise marks on 

specially printed forms and sheets. 

It is used to read characters printed in a 

special font using magnetic Ink. 

OMR is used in checking the answer 

sheets of competitive exams where 

MCQs are asked.  

MICR is used to process cheques in 

bank. 

 

   

 2. What is the significance of the RAM and ROM? 

  RAM is a read/write memory used to store information. The amount of RAM installed in a 

computer decides the number and size of programs that the system can run simultaneously. 

ROM is a computer memory in which data is pre-recorded. It is used to store a special piece of 

software called BIOS. It helps in loading operating system when computer is switched on. 

 3. What is the use of a graphic tablet? 

  A graphic tablet is used to draw images and pictures on the computer screen.  

It consists of a flat surface on which the user can draw using a pen-like drawing device called 

stylus. Graphic tablets are of great use to artist who like to draw directly on the computer. 



 

 4. Distinguish between primary memory and secondary memory. 

   

  Primary Memory  Secondary Memory 

It is known as main memory or internal 

memory. 

It is known as auxiliary memory or 

external memory.  

Data stored in it can be directly 

accessed by the CPU 

It is used to store data permanently. 

 

Example: RAM, ROM Example: Hard-disk, Pen drive, CD-

ROM 
 

 5. Define Biometrics devices. List down some of the places where they are used and for what 

purpose. 

  Biometric devices are the devices which can identify a person’s identity on the basis of their 

distinctive physical characteristics. 

The places where biometric devices are used: 

-Offices   -Passport Offices   -Airport -Work places -Banks  

-For unlocking mobile phones. 

 6. What is the advantage of LED monitors over LCD Monitors? 

  LED monitor produces images with higher contrast, produce less heat, have a very thin design 

and are environment friendly. 

 7. What is QR code? 

  A QR code is a two-dimensional code that consist of an array of black and white squares. 

QR code stands for quick response code. 

QR code can store more information than a bar code. 

They are seen on business cards, billboards, products and so on. 

   

   

   

   



 

HOTS 

   

  Find the odd one out. 

  1. RAM, CD, DVD, Pen drive 

  2. Touch Screen, LCD Projector, Scanner, Biometric  

  3. Plotter, Printer, OMR, Monitor 

  4. Dot-Matrix printer, Daisy wheel printer, Line printer, Laser printer 

  5. Scanner, Bar Code reader, Digital Camera, Plotter 



 

 

 

Chapter 2 Working in Windows 10 

 

Practice Zone [Page no 25] 

 
 Q1 State whether the following statements are True or False. 

 1. An Operating system acts as an interface between the user and the hardware.True 

 2. Notification area is located on the extreme left of the taskbar.False 

 3. In GUI based OS users had to write text-based commands to perform any task on a 

computer.False 

 4. Operating system keeps track of memory usage and allocates and deallocates memory space 

as needed. True 

 5. We can create virtual desktops on windows 10. True 

 6. The Start Menu has options that let you view all apps or programs. True 

   

Assessment Zone [Page no 31-33] 

 
A.  Choose the correct answer. 
 1. Which of the following is not a function of the operating system? 

  a. Database management 

  b. Input/output Device management  

  c. Main Memory Management 

  d. Secondary Storage Management 

 2. Which of the following is not present on the taskbar? 

  a. Start Button 

  b. Notification area 

  c. Task View Button 

  d. Personalize option to set the desktop background 

 3. Which of the following icon would you double-click to access the contents stored on 

the hard drive and drives connected to the computer? 

  a. Recycle Bin 

  b. This PC 

  c. Task View Button 

  d. None of these 

 



 

 

 

 

 4. The left side of the start menu in windows 10 lets you  

  a. access all apps 

  b. access the power button 

  c. access the file explorer window 

  d. All of these 

 

B.  Fill in the blanks using words given in the box. 

 
  1. Task View button enables you to view thumbnail icons of all open windows. 

  2. Tiles in the start menu that keep changing the information they display are known as 

live tiles. 

  3. The small pictures on the desktop which when clicked open programs are called 

icon. 

  4. The Operating system is responsible for executing various programs whether user 

or system programs. 

  5. Notification area on the taskbar tells the status of certain programs running on your 

computer. 

C.  State whether the following statements are true or false. 
  1. Operating system is responsible for creation and deletion of files and folders and 

free space management. True 

  2. The notification area displays the icons for programs pinned on the taskbar. False 

  3. When you click a shortcut on the desktop, it opens the associated programs or 

applications. True 

  4. Tiles present on the start menu cannot be resized. False 

  5. You cannot set a slideshow of pictures for the desktop. False 

 

D.  Answer the following questions. 

 
 1. What are the functions of an operating system? Discuss them briefly.  

  An operating system acts as an interface between the user and the hardware. 

The important functions of an operating system are: 

Resource Allocator: The operating system acts as a manager of these resources and 

allocates them to specific programs and user as necessary.  



 

 

Program Execution: The operating system is responsible for executing various programs 

whether user or system programs. 

Main memory management: Operating system keeps track of memory usage, decides 

which processes are to be loaded, into main memory when space is available.  

File Management and Secondary Storage management: Operating system looks into 

various aspects like creation and deletion of files, folders, and free space management. 

Input/output Management: Operating system interact with various device drivers to get 

input from user and generate some output. 

 2. Discuss the purpose of the various sections of the Taskbar. 

  There are six different sections available on taskbar: 

  1. Start Button: It appears at the bottom left corner of the taskbar, when you click this 

button a list of options or programs appears. 

  2. Search box: We can use the search box to search for only file or app on the 

computer. It can also be used to search for information on the Internet. 

  3. Task View Button: We can use task view button to view thumbnail icons of all 

running application window. 

  4. Middle section of the Taskbar: The middle section of the Taskbar displays icons 

for programs pinned on the taskbar. 

  5. Notification Area: It displays a clock and a group of small icons. 

  6. Peak Button: Clicking this button minimizes all open windows and displays the 

desktop. 

 

 3. Describe the start menu in Windows 10. 

  Start menu appears at the bottom left corner of the taskbar. 

When you click this button, A list of options or programs appears. 

The start menu shows the most frequently used apps on the left side. 

By clicking on “All apps” button you can see all the application installed in your system. 

The tiles on the right side of the start menu usually open window’s stored application. 

   

   

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

HOTS 

 
  Study the image and answer the question that follows. 

   

  

 
 

  1. What is the use of area marked A in above figure? 

It is used to search for any file/folder. 

  2. What happens when you click on the personalize option (Label B)? 

It helps to personalise the appearance of the desktop. 

  3. What is the significance of the icon (Label C)? 

This icon is of Recycle bin. It is used to store deleted files/folders. 

  4. What is area labelled D known as? 

Notification Area 

  5. Give the use of buttons labelled E and F? 

E: Start Menu: It allows you to view the list of programs or apps. 

F: Task View Button: It is used to view thumbnails of all running application 

windows. 

 

 



 

 

 

 

 

 



 

 
 

 

Chapter 3 Advance Features of Microsoft Word-2013 

Practice Zone [Page no 38] 

  Fill in the blanks with the correct option: 

 1.  Option B is used for inserting header in the document. 

 2. Option E is used for inserting footer in the document. 

 3. Option D is used for inserting page number in the header or footer. 

 4. Option A is used for inserting date and time in the header or footer. 

 5. Option C is used for inserting picture in the header or footer. 

 

  Practice Zone [Page no 48] 

 1. You can use table to present information in an organized manner. 

 2. The design and layout tabs appear whenever you are working on a table in word. 

 3. The merge cell option lets you combine two or more cells in a row or a column into a 

single cell. 

 4. You can use the properties option on the layout tab to change row height or column 

width. 

   

Assessment Zone [Page no 59-61] 

A.  Choose the correct answer. 

 1. Which of the following contains information about recipients like names, addresses 

and phone numbers in the mail merge process? 

  a. Main document 

  b. Merged document 

  c. Data Source 

  d. Tables 

 2. While working on a table, which of the following options lets you combine together 

two or more selected cells in a table? 

  a. Merge Cells 

  b. Split Cells 

  c. Table properties  

  d. Insert 



 

 
 

 3. Which feature in word will help you to insert date, time, page numbers or the title of 

the document, in the top or bottom margins of a document? 

  a. Cut and paste 

  b. Copy and paste 

  c. Mail merge 

  d. Header and Footer 

 4. Creating letters using mail merge involves? 

  a. Opening or creating the main document 

  b. Opening or creating main document and data source and then merging the 

data source with main document 

  c. Opening or creating the data source 

  d. None of these 

 5. Tables group is present on the ________ tab. 

  a. Home 

  b. Insert 

  c. Page layout 

  d. Review 

   

B.  State whether the following statements are true or false. 

 1.  You can insert new rows only at the end of the table-False 

 2.  Mail merge feature is useful when you have to type different letters. -False 

 3.  You can include both text and graphics in the header and footer sections of your page. 

True 

 4.  The home and layout tabs appear automatically when a table is inserted in a document. -

False 

 5.  You can add borders around the table or around the selected group of the cells. – True 

 

C.  Fill in the blanks using words given in the box. 

 1. The mail merge feature of word lets you create multiple copies of letters or emails with 

more or less similar text. 

 2. You can make use of the split cells option on the layout tab to divide a single cell into 

multiple cells in a table. 

 3. Intersection of a row and column forms a cell. 

 4. The design tab has various table styles that let you format the table quickly. 



 

 
 

 

D.  Answer the following questions 

 1. Give the significance of the Header and Footer option. 

 Ans The Header and Footer option allows you to insert text or graphics at the top or bottom of 

each page in your document. 

This option is very useful for inserting chapter names, logos or pictures, page numbers, 

date and time and so on across all the pages. 

 2.  The Layout tab appears when a table is inserted in the document. List some options  

that are present on this tab?     

 Ans      Following are some options present on Layout tab: 

1. Draw table 

2. Eraser 

3. Delete 

4. Alignment 

5. Insert Rows and Columns 

6. Merge/Split Cells/Table 

7. Cell Size 

8. Sort, Formula etc. 

 3. .      Discuss the two ways by which you can change the row height in a table. 

 Ans There are two methods to change the row height. 

1. By using the mouse pointer  

2. By using the option available on the Layout tab 

 4. What are the three main stages of mail merge process? 

 Ans 1. Creating the data source. 

2. Creating Main Document. 

3. Merging the Data Source with the mail Document (Mail Merge). 

   

 

 

 

 

 

 

 



 

 
 

  HOTS 

A.  Riya is working on her maths project and has typed the following table. 

 KNOW ABOUT NUMBERS 

EVEN NUMBERS Numbers those are divisible by 2. 

ODD NUMBERS Numbers that are not divisible by 2. 

PRIME NUMBERS Numbers divisible by 1 or the number itself. 

TWIN PRIME NUMBERS Pairs of prime numbers that have a difference of two 
 

   

 1. She wants to add another column to give examples of the numbers. Write steps to 

help her to achieve the following outcome. 

KNOW ABOUT NUMBERS  

EVEN NUMBERS Numbers that are divisible by 2. For example:2,4,8 

ODD NUMBERS Numbers that are not divisible by 2. For example:3,5,9 

PRIME NUMBERS Numbers divisible by 1 or the 

number itself. 

For example:2,3,5 

TWIN PRIME 

NUMBERS 

Pairs of prime numbers that have a 

difference of two 

For example: (3,5) 

(5,7) 
 

 Ans 1. Position the cursor in the column to the right of which a new column is to be 

inserted. 

2. Click on the Layout tab. 

3. Click on Insert Right.  

4. A new column gets inserted in the table. 

 2. 

 

 

 

 

 

 

 

 

 

 

 

She wants the heading “KNOW ABOUT NUMBERS” to be on one cell on top of the 

table. Write the steps to help her to achieve the following outcome. 

 

 KNOW ABOUT NUMBERS 

EVEN 

NUMBERS 

Numbers that are divisible by 

2. 

For example:2,4,8 

ODD 

NUMBERS 

Numbers that are not divisible 

by 2. 

For example:3,5,9 

PRIME 

NUMBERS 

Numbers divisible by 1 or the 

number itself. 

For example:2,3,5 

TWIN PRIME 

NUMBERS 

Pairs of prime numbers that 

have a difference of two 

For example: (3,5) (5,7) 



 

 
 

Ans 1. Select the cells to be merged. 

2. Click on the layout tab. 

3. Click on Merge Cells. 

 3. Riya decides that she does not want to include the description of twin prime 

numbers. How can she remove the row from the table? 

 Ans. 1. Select twin Prime Numbers row 

2. Click on Delete Cells option  

 4. 

 

 

 

 

 

 

 

 

 

 

 

Ans. 

Riya decides to add another row above the second row to achieve the following result. 

Write the steps to help her accomplish this task. 

 KNOW ABOUT NUMBERS 

NUMBER 

CATEGORY 

DESCRIPTION EXAMPLE 

EVEN 

NUMBERS 

Numbers that are divisible by 

2. 

For example:2,4,8 

ODD 

NUMBERS 

Numbers that are not divisible 

by 2. 

For example:3,5,9 

PRIME 

NUMBERS 

Numbers divisible by 1 or the 

number itself. 

For example:2,3,5 

 

1. Position the cursor in the even number’s row then select the insert row above. 

2.Then write title NUMBER CATEGORY, DESCRIPTION and EXAMPLE. 

 5. 

Ans. 

How can she improve the appearance of the table? 

By applying design from Design tab. 

 



 

 

Chapter 4 Enhancing a presentation 

 

Practice Zone [Page no -71] 

  State whether the following statements are True or False. 

 1. It is not possible to use video and audio files available online in the presentation. False 

 2. You can record your own voice and insert it in a presentation. True 

 3. An audio file inserted on the first slide can be made to play till the end of the presentation. 

True 

 4. A video cannot be played in full screen during the slide show. False 

 5. You can trim an audio or video file inserted on the slide. True 

   

Practice Zone [Page no -81] 

 1. A transition effect can be applied to the individual objects on the slide. False 

 2. There are four categories of animation effects .True 

 3. You can apply multiple animation effects on an object. True 

 4. The rehearse Timing feature lets you save the timings for a slide show. True 

 5. You can only see the animation effects or transition effects by running the slide show. 

False 

   

Assessment Zone [Page no 83-85] 

A.  Choose the correct answer. 

 1. The __________tab has the option to print power point slides. 

  a. Animation 

  b. Slideshow 

  c. Design 

  d. File 

 



 

 

 2. Which of the following is not a category under the Animation effects? 

  a. Entrance  

  b. Enhance 

  c. Emphasis 

  d. Motion Paths 

 3. Identify the odd one out. 

  a. Play Full screen 

  b. Fade in 

  c. Video Effects 

  d. Trim Video 

 4. Identify the incorrect statement. 

  a. You can reorder the animation effects using animation pane. 

  b. The Animation Pane lets you play the animations on a slide. 

  c. A new picture can be added to the slide using the Animation Pane. 

  d. You can set the start option for animation effects using the Animation Pane. 

 5. The Special effects used to introduce slides in a presentation are called 

  a. Effects 

  b. Animations 

  c. Transitions 

  d. Present animations 

 6. Before delivering a presentation, you want to change the order in which the objects 

appear during the slide show. Which of the following options will allow you to 

change the setting?  

  a. Animation Pane 

  b. Transition Pane 

  c. Playback tab 

  d. Rehearse timings 

   

 

 

 



 

 

B.  Fill in the blanks using word given in the box. 

 1. The trim audio option on the play back tab can be used for selecting the desired part of 

the inserted sound file. 

 2. The Format and Playback tab appear when you insert an audio or video file on a slide. 

 3. You should apply Motion Path animation effects on an object to make them move on the 

slide on the specific path. 

 4. Transition effects appear when one slide changes to the other during a slide show. 

 5. You can make a slide show run according to the recorded timings by using rehearse 

timings option on the slide show tab. 

   

C.  State whether the following statements are true or false: 

 1. Music and sound can be set to play automatically with slide during a slide show. True 

 2. Picture on a slide cannot be animated. False 

 3. It is compulsory for the user to click to change one slide to the other. False 

 4. You can record the slide show timings. True 

 5. Slides can be printed on a paper in landscape or portrait orientation. True 

 6. It is necessary for you to print all the slide of presentation. False 

   

D.  Answer the following questions. 

 1. Mention the various ways in which sound can be added to a presentation. 

 Ans 1. Insert sound from an audio file saved on the computer. 

2. Insert sound by searching for an online audio file. 

3. Record sound. 

 2 What are the four categories of animation effects? 

 Ans. The four categories of animation effects are : 

1. Entrance effects 

2. Emphasis effects  

3. Exit effects 

4. Motion effects 

 



 

 

 3. What are slide transition effects? How do you assign these effects? 

 Ans. Transition effects appear when one slide changes to the other during a slide show  

Steps to add slide transition effects 

1. Click on the transition tab. 

2. Click on more button in the transition to This Slide Group to display all transition 

effects. 

3. Click and choose a transition effect.  

4. Click on the effect options in the Transition to this slide group to select an effect 

for the chosen transition. 

5. Specify the time. 

 4.        How can you display a slide for a specified time during the slide show? 

 Ans You can either set the timing for your slides manually or automatically while you 

rehearse. 

 5. Name a few options that should be set before printing a presentation. 

 Ans 1. Print all slides 

2. Print current slides 

3. Print selection 

4. Custom range to print specific slides 

   

   

 

 

 

 

 

 

 

 

 



 

 

 

HOTS 

A.  

 

 

Ans 

Riya is applying animation effects to the various objects on the slides. She is a little 

confused because a number appears next to the object whenever an animation effect 

is applied. Explain the reason behind these numbers and their significance to Riya. 

This implies that an animation effects has been applied on the object. The number next to 

objects shows the sequence in which they appear when she plays slide show. 

B.  Observe the following image carefully and answer the following questions: 

  

 

 1. 

Ans 

Why does the first slide have star symbol next to it in the slide outline pane? 

It is because transition effect has been applied on it. 

 2. 

Ans 

What do the numbers next to the title, picture and text indicate? 

It indicates the sequence of objects in slide show.  

 3. 

Ans 

What is the use of buttons in the animation pane? 

The animation pane lets you view, modify and reorder the animation effects applied on 

objects on a slide. 

 4. 

Ans 

Which Transition effect has been applied on the slide? 

Wipe Transition effect has been applied on the slide. 

 5. 

Ans 

What happens when we specify a value in the timing group on the transitions tab? 

It will play the slide show for the that much amount for transition when we play slide 

show.  



 

 

Chapter 5 Getting started with Microsoft Excel-2013 

 

Practice Zone [Page no 94] 

  State whether the following statements are true or false. 

 1. The formula bar contains the contents of the current cell. True 

 2. The entry 345S will be treated as a text entry in excel. True 

 3. The address of cell formed by intersection of row 5 and column D is 5D. False 

 4. A workbook is a collection of only three worksheets. False 

 5. We can enter symbols such as , and % in a number value. True 

   

Assessment Zone [Page no 99-101] 

A.  Choose the correct answer. 

 1. Which area in an excel window displays the address of the current cell? 

  a. Name box 

  b. Formula bar 

  c. Status bar 

  d. Quick Access toolbar 

 2. What is the Auto Fill feature of Excel? 

  a. It automatically completes abbreviated words. 

  b. It completes numeric entries that match an existing entry in the same column. 

  c. It fills cells with a series of numbers, dates or items that follow a particular pattern. 

  d. All of the above 

 3. Which of the following will not be treated as a number value in Excel? 

  a. 45,000 

  b. $23400 

  c. 567% 

  d. (89)-2345 

 



 

 

 4. The Flash Fill option is present under which tab? 

  a. Home  

  b. Data 

  c. Insert  

  d. Review 

   

B.  Fill in the blanks using word given in the box. 

 1. A cell is formed when a row and a column intersect. 

 2. Jan, Feb, Mar, …. Series can be generated using the Auto Fill feature of Excel.  

 3. A feature that lets you fill the data in cells by picking up the pattern set in the example is 

FlashFill. 

 4. Formula bar displays the contents of the active cell. 

 5. A group of cells adjacent to each other forming a rectangular shape is referred to as range of 

cells. 

 6. A collection of worksheets stored under a single file name is called workbook. 

   

C.  Answer the following questions 

 1. What is the difference between a worksheet and a workbook? 

 Ans Worksheet is a work area made up of horizontal rows and vertical columns where in you enter 

and work with data. 

Workbook is a collection of multiple worksheets stored under a single file. 

 2 What are the difference types of data that can be entered in Excel? 

 Ans Followings are the different types of data that can be entered in Excel. 

1. Numbers 

2. Date and Time 

3. Formulas 

4. Text 

 3. Give the cell address of the cell formed by the intersection of: 

 Ans 1. Twentieth row and seventh column- G20 

2. Hundredth row and eighth column - H100 



 

 

   

 4. 

Ans 

Discuss any two ways to add new worksheet in Excel. 

1. The quickest way is to click the new sheet button at the end of the worksheet tab. 

2. Click the arrow below the Insert option in the cells group on the Home tab. A drop-

down list is displayed choose the Insert Sheet option. 

   

 5. 

Ans 

What is difference between Auto fill and Flash fill features in Excel? 

 

Auto Fill Flash Fill 

Auto fill is a feature in Excel that allows 

you to quickly create a series of numbers 

dates or other items that follow a 

particular pattern. 

Flash Fill is a feature that fills the data 

in cells by picking up the pattern set 

in an example. 

E.g. 2,4,6… or Mon,Tue,Wed… Ex from Full Name, First name can be 

extracted. 
 

   

   

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

HOTS 

   

A.  Observe the following image carefully and answer the following questions: 

 

  

 

 

 1 

Ans 

Name the feature used to generate the series: Jan, Feb, … 

Autofill 

 2 

Ans 

What is the present content of the Name box? 

B4 

 3 

Ans 

What is the present content of the Formula bar? 

13-02-2016 

 4 

Ans 

Identify the cells containing date values 

B3 to B8 

 5 

Ans 

Identify the cells containing text data 

A1, B2, C2, D2 
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